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1   Calibrating the Printer

This section includes instructions for calibrating the family of Kodak Professional 
CRT Printers.

Kodak provides calibration applications for Windows NT and, except for the 
KPDM II, Macintosh systems. 

See “Installing the Calibration Software” on page 2-2 for installation instructions. 
See Section 2, Using Additional Calibration Features, for details about the 
windows and dialog boxes for the application software and for additional 
procedures not performed with each calibration.

Calibration is the process for creating and maintaining a Look-Up Table (LUT) that 
produces the correct color balance for all images printed on the Printer. There is 
sufficient variation among printers that each printer must be calibrated separately.

Over time, there are several conditions which can contribute to calibration 
deviation. To prevent this potential deviation, it is recommended that you calibrate 
the Printer when you change paper type (paper emulsion, surface, lot number, 
and width) or when the calibration test target print is out of tolerance. 

IMPORTANT: For the CRT Printer Family calibration, the term “device” refers to a 
setup for a specific paper type/scale combination.

You can add, update, and delete devices as needed.

Before calibrating, make sure that:
• within the Kodak Professional Device Calibration software, for each paper 

type/scale that your lab uses:
— a device is defined (see “Adding a Device” on page 2-10)
— any needed changes to the configuration file are in place (see “Editing the 

Device Configuration File” on page 2-17)
— frame counts are determined (see “Determining Frame Counts for a 

Device” on page 2-32)
• the paper path is threaded 
• no other printer applications are active
• the densitometer is connected and calibrated
• the paper processor is in control
• the printer status as shown at the OCP is “Ready” (not “Printing”)
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NOTE: If the Printer is threaded and its status is Offline, press 
Jog&Start at the OCP to advance the paper and change the status to 
Ready.

During calibration, when making a print of the test target:

• wait 15 minutes or longer after exposing a test target before processing to 
stabilize latent image keeping (LIK) 

• read the second of the three test target prints with an X-Rite DTP36 
densitometer.

Starting the Device Calibration Software
1. From the desktop of the host computer, open the KODAK PROFESSIONAL 

Device Calibration application.
The display shows the Device Calibration window. If no device icon is in the 
window or there is no icon for the device you need to calibrate, see “Adding a 
Device” on page 2-10.

2. Select the icon for the device (printer and scale) to calibrate.

3. Click the Calibrate icon. 

Device icon
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The display shows the CRT Print Family Calibration Application window.

Starting the Calibration Application and Exposing a 
Test Target

IMPORTANT: The settings in the configuration file for the selected device 
determine some of the actions and messages in this procedure. 
The configuration file is specific to your lab and its operations. For 
more information about the configuration file, see “Editing the 
Device Configuration File” on page 2-17.

The instructions for the calibration procedure give options at each step. However, 
the software is designed so that once you select Go to begin, the default is 
highlighted so you can select the simplest option in each case. This means you 
can calibrate with minimum intervention or decision-making.

1. Click Go on the Calibration window.

NOTE: If needed, you can cancel the calibration application at any time when 
the Stop icon (red traffic light) lights.
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The Downloading LUTs and Exposing Test Print status icon highlights and (if 
“Ask if processor is in control?” in the configuration file is On) the display 
shows the Process In Control dialog box below.

IMPORTANT: The processor is a critical component of printer calibration; 
monitor it on a regular basis. Calibration can not be accurate if 
the processor is not in control.

2. From the Process in Control dialog box above, click Yes (or No to exit the 
calibration procedure).
The display shows the Choose PaperPak dialog box.
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3. Either:
• with the selected PaperPak highlighted, click Load Selected PAP, or
• click Load Custom PAP; then browse the standard file dialog that allows 

PaperPaks to be imported from other areas on the hard disk or from a 
removable disk; select the PaperPak file you need.
The default location for PaperPaks is the CalLUTS folder.

(Click Cancel on the Choose Start PaperPak dialog box to exit.)

When the PaperPak has been selected, the display shows the Confirm/Edit 
Frame Counts dialog box.
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4. Make sure the frame counts are correct, as established by your lab.

5. Click OK, or if needed, edit the frame counts and then click OK.

NOTE: During the initial setup process for the Printer, your lab tests and sets 
frame counts. See “Determining Frame Counts for a Device” 
on page 2-32.

The display shows the Choose Starting LUT dialog box. The highlighted LUT 
is the most recent calibration LUT. If this is the initial calibration for the device, 
the 12-Bit Factory Default is highlighted.

6. Either:
• with the starting LUT highlighted, click Load Selected LUT, or
• click Load Custom LUT; then browse the standard file dialog that allows 

LUTs to be imported from other areas on the hard disk or from a removable 
disk; select the LUT file you need.
The default location for calibration LUTs is the CalLUTS folder.

(Click Cancel on the Choose LUT dialog box to exit.)
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After the LUT file has been selected, “The LUT was sent successfully” shows 
on the status bar. With the PaperPak and the LUT, the Printer can expose a 
print of the test target. 

NOTE: The factory default for the number of copies printed is 3. 

When the prints have been exposed, the Scanning Processed Print with 
Densitometer icon highlights.

7. At the OCP, perform a Batch Cut. 

8. Wait for latent image keeping (LIK) to stabilize before processing. The 
minimum suggested time is fifteen minutes.

9. Send the test target prints to be processed. 

Continue with “Obtaining Densities.”
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Obtaining Densities
There are three methods for obtaining densities: 

• from a file

• from a densitometer

• from a centralized densitometer (NT only and only if the Centralized 
Densitometer application is installed on your network)

The contents of the device configuration file determine which method you use 
(see “Editing the Device Configuration File” on page 2-17).

Obtaining Densities from a File

If the configuration settings include obtaining the density data from a file, the 
display shows the Waiting for Density File dialog box. 

If the configuration settings do not include obtaining the density data from a file, 
go to either:

• “Using the Densitometer to Read Densities” on page 1-9 or 

• “Obtaining Densities from the Centralized Densitometer (NT Only)” 
on page 1-11

NOTE: To create a density file, see “Creating a Density File for Use with Calibration” 
on page 2-55.

1. Click OK to continue with the calibration process. 

2. Go to “Completing the Calibration Procedure” on page 1-12.
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Using the Densitometer to Read Densities

For the most accurate reading, cut the second of the three test target prints and 
read its densities with an X-Rite DTP36 densitometer, as specified in this 
procedure.

1. Trim the processed test target print on the dashed line and along the top so 
the print passes through the densitometer at the correct locations.

2. Align the pass 1 arrowhead on the print (shown below) with the vertical 
groove on the front of the densitometer. 

3. Put the print firmly in the densitometer. Keep a slight pressure on the print as 
it moves through the densitometer until you feel a resistance and the display 
shows “Reading.”

A short beep from the densitometer, followed by “Pass 1 of 4 OK”, indicates a 
successful read. “Read EKT-CRT PA2” is displayed next, indicating the 
densitometer is waiting for the next pass. 

A long beep with a message to re-read the pass indicates an unsuccessful 
read. Read the same pass through the densitometer again. If the read 
continues to be unsuccessful, cancel, then restart the calibration.
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4. When the read is successful, repeat steps 2 and 3 until all four passes are 
complete. Align the arrowhead at passes 2, 3, and 4, respectively. 
For instructions on using the densitometer, see the densitometer manual.

When “Density values received” shows on the status bar, continue with 
“Completing the Calibration Procedure” on page 1-12.

If the Density Readings are Unsuccessful

If either of the two dialog boxes below are displayed, click Retry after making sure 
the densitometer is on and the connection is secure.
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Obtaining Densities from the Centralized 
Densitometer (NT Only)
NOTE: For more information about installing and using the Centralized 

Densitometer Application, see Section 3, Installing and Using the 
Centralized Densitometer Application.

If the configuration settings include obtaining the density data from the centralized 
densitometer application, a message is displayed in the status bar. 

1. Open the Centralized Densitometer Application. The display shows the 
Centralized Densitometer Application window.

2. Highlight the device.

3. Click Measure or select Operations->Measure to measure the target images.



4. At the densitometer, measure the densities (see “Using the Densitometer to 
Read Densities” on page 1-9).
When the densities are measured, the status bar on the Centralized 
Densitometer Application window displays “Ready.”

The measured densities are automatically sent to the CRT printer’s host 
computer.

Continue with “Completing the Calibration Procedure.”

Completing the Calibration Procedure
The Calculating LUTS & Downloading to the Printer status icon highlights.

1. If calibration is in tolerance, the display shows the LUT Attributes dialog 
box. 

a. Enter a name or comment in the dialog box. The comment you enter will 
appear on the Send LUT to Printer dialog box to identify the LUT file with a 
name that is meaningful to you (up to 75 characters).

b. Click OK. 

The new printing LUT is calculated and downloaded. The status bar shows 
“Calibration Complete.” 

2. If calibration is out of tolerance, it may be necessary to run four or more 
iterations of the calibration cycle to achieve a successful calibration.
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If the print densities are out of tolerance, the display shows a graph, allowing 
you to select the type of data and planes that you want to see displayed.

a. Click OK. 
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If specified in the configuration file, the display shows a list of options.

Re-read the densitometer values is most useful when the graphs show 
an unusual plot. Rereading the test print lets you validate the graph, then 
returns you to the Out of Tolerance dialog box.

Iterate again using a newly calculated calibration LUT allows you to 
print another test print with the newly calculated LUT and see if this brings 
the printer within tolerance.

Calculate and download a printing LUT and stop: When you select this 
option, the LUT is calculated and the file is saved with the creation date 
and time as its name.

Cancel and return the printer to its original state saves nothing. Any 
corrupted data created after you saved the last time is thrown away.

b. Select one of the four options to try to complete the calibration 
successfully.

Exiting the Calibration Procedure

To exit the Calibration window, select Quit from the File menu on the Calibration 
window.

To exit the Device Calibration window, select Quit from the File menu on the 
Device Calibration window.
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2   Using Additional Calibration Features

The topics covered in this section include:

• Installing the Calibration Software

• An overview of the Kodak Professional Device Calibration software

• Instructions for using functions of the Kodak Professional Device Calibration 
software that are not normally part of the calibration routine. These functions 
include:
— Editing the log settings (applies to all devices)
— Adding, updating, or deleting a device
— Editing the configuration file for a device
— Determining starting frame counts
— Sending a PaperPak (frame counts) to the Printer
— Sending LUTs (Look-Up Tables) to the Printer
— Sending test targets to the Printer
— Viewing graphs

• Installing the densitometer

IMPORTANT: For the step-by-step procedure to calibrate the printer, see 
Section 1, Calibrating the Printer.

The information in this section is intended for a lab technician or a person with 
experience in computer systems and photographic science.

The screen captures in this manual are primarily from the Windows NT platform. 
Macintosh users may notice minor variations in individual user screens. Functions 
and procedures remain the same unless noted.



Using Additional Calibration Features

2-2

Installing the Calibration Software
Installing the software includes installing both the Kodak Professional Device 
Calibration Software (which manages the calibration of multiple Kodak devices) 
and the Calibration Software for the family of Kodak Professional CRT Printers.

You can install the software either from a supplied CD or by downloading from the 
Kodak web site.

System Requirements

MACINTOSH Systems

• Power MACINTOSH System 7.5 or above

• Minimum of 100 MB free disk space

• 960 K free disk space for each of as many as six configured devices

• 256 colors at 640 x 480 spatial resolution

• CD ROM Drive

WINDOWS NT Systems

• WINDOWS NT 4.0 operating system with at least Service Pack 3

• 100 MHz PENTIUM Processor

• 64 MB Main System Memory

• VGA Monitor (640 x 480 spatial resolution)

• CD ROM Drive

Installation Procedure
1. If you are installing the software from the supplied CD-ROM: 

a. Place the CD in your CD-ROM drive. 

b. When the Browser is displayed, select the CRT Printer type you are using.

2. If you are downloading the installation files from the Kodak web site, go to 
http://www.kodak.com/global/en/service/software/kproHost/kpdm.shtml. 

http://www.kodak.com/global/en/service/software/kproHost/kpdm.shtml
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3. Under the heading Product Support, select Drivers, Software and Firmware.

4. Select Calibration Utilities.

5. Under the heading Download File, select KODAK PROFESSIONAL Device 
Calibration.
The display shows the Save As dialog box. 

6. Either accept the default path and file name or select another path and file 
name and save the file. 

NOTE: The installation is similar for NT and Macintosh systems. When the 
instructions say, for example, click Next or Install, the first option is for NT 
systems; the second is for Macintosh systems.

CAUTION: To avoid possible damage, do not connect or disconnect the cable 
between your host computer and the printer when either device 
is powered up.

7. Open the installation file (KODAK PROFESSIONAL Device Calibration.exe).
The display shows the splash screen for KODAK PROFESSIONAL Device 
Calibration and a Setup message.
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8. After the Welcome dialog box is displayed, click Next or Continue.

9. For Macintosh systems only, read the readme information, then click 
Continue.

10. Read the license agreement.
• To accept the terms and continue the installation, click Yes or Agree. 
• Or, to cancel the installation, click No or Disagree.

11. For NT systems only, read the readme information, then click Next.

12. Select the installation type:
For NT systems, select one of the following:

NOTE: The Compact option is not supported.

• Typical includes Device Calibration Applications for the family of 
Kodak Professional CRT Printers and for the Kodak 
Professional LED Printer, plus the Linearization Calibration 
Application for the Kodak Professional RFS 3570+ (Speed 
Up) Film Scanner

• Custom allows you to choose specific features for the application you 
choose to install, including the Centralized Densitometer 
Application; within the CRT Printer Family, you can choose 
the LFCRT, 4-inch CRT Printer, KPDM, or KPDM II.

For Macintosh systems, select Easy Install.

13. Click Next to install the software on your system.
The display shows a dialog box for you to designate where to install the 
calibration software.

14. Either accept the default path and folder or select another path and folder. 

15. Click Finish or OK.

NOTE: For NT systems, the dialog box gives you the option of reading the 
readme file associated with your installed applications. 

16. If you installed the software from a CD-ROM, remove the CD and store it in a 
safe place.
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About the Kodak Professional Device Calibration 
Software

The Kodak Professional Device Calibration software manages and launches 
customized calibration software applications, including the calibration software for 
the CRT Printer Family. 

Below is the window for the Device Calibration software. 

Description of Bars and Icons on the Device 
Calibration Window
The descriptions of the bars and icons apply to the Device Calibration windows. 
Menu bar Contains user selectable menu items
Title bar Contains the application name, “KODAK PROFESSIONAL 

Device Calibration”
Status bar Displays status or informational message
Device icon Represents a device that can be calibrated 
Tool bar Contains user selectable menu choices activated by a shortcut 

keystroke or by a mouse pointer and left mouse button

 
Device icon

Title barMenu bar

Tool bar

Status bar
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About the Calibration Software for the CRT Printer 
Family

The calibration software for the family of Kodak Professional CRT Printers 
provides automated neutral density printer calibration and is designed to be used 
without assistance from technical experts. 

NOTE: Printer calibration is one part of a color management system. Other aspects 
of color management are provided by applications that are independent of 
the Printer and the calibration software.

Calibration Window

The CRT Printer Family Calibration Application window is displayed and 
described below.

Status iconTool bar Title bar

Status bar
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Tool bar Contains user selectable menu choices; activated by a shortcut 
keystroke or by a mouse pointer and left mouse button

Title bar Top bar of the Calibration window; contains the name of the 
device being calibrated

Status icon Illuminates to graphically indicate the current status of the 
calibration process

Status bar Displays messages to the user that indicate actions or status of 
the calibration process

The table below defines the status icons on the Calibration window for the Printer.

Function Icon Description

Calibration Step 1 This area is highlighted while the application 
is:
• initializing the Printer
• getting the current LUT and current 

PaperPak from the Printer
• sending the starting calibration PaperPak
• sending the starting LUT
• sending the test target image

Calibration Step 2 This area is highlighted while the application 
is waiting for density data. The density data 
is read through the densitometer from the 
processed test target, unless specified to be 
read from a file. 

Calibration Step 3 This area is highlighted while the application 
is
• calculating new LUTs and 
• sending the new printing LUT to the 

Printer
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Editing the Log Settings 
Your Device Calibration application has specific “log settings” for the purpose of 
keeping a history of the calibration. You may want to change the settings—the 
type of messages written to the log file, the number of days to keep the log file, 
and the name of the log file.

The log records calibration-related events and errors. The default log settings are:

• keep log for 30 days

• log all actions (events and errors)

• logfile.txt as the file name

To change the log settings for the Device Calibration:

1. On the KODAK PROFESSIONAL Device Calibration window, deselect all 
devices. 

2. Click the Edit icon or select File->Edit.
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The display shows the Edit Configuration dialog box with the default settings:

3. Edit the log settings as needed. Settings and their options are:
Keep log for (days): you can keep logged data for as many as 99 days

Log Type—you can specify:
• All – log all errors and events
• Errors – log only errors
• Events – log only events
• None – do not log any actions
Log File Name—name of the file to which log entries are written.

4. Select OK to save the changes (select Cancel to exit; select Default to 
display the default settings and then OK to save the defaults).

NOTE: See also “Editing Information on the History Tab” on page 2-25. 
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Adding, Updating, and Deleting Devices
A calibration device represents a printer type. For CRT printer types it is also a 
specific printer/scale combination with additional attributes defined by its 
configuration file.

You can:

• add new devices

• update the name or SCSI ID (Target ID) of an existing device

• delete devices

• update the configuration files for devices

Adding a Device

1. Click the New icon or select File->New on the Device Calibration window.

The display shows the Create a New Device dialog box.

NOTE: Other applications may refer to the SCSI ID as the Target ID and to the 
SCSI Host Adapter as the SCSI Port. The terms are interchangeable.
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2. Enter a unique identifier as the device name. The device name must be 
alphanumeric with no spaces or special characters. It can contain as many as 
10 characters.

CAUTION: Calibration can be performed only if the SCSI ID (or Target ID) 
information is correct.

3. Enter the correct SCSI ID information.
The factory default is 2. 

a. To use your host computer to determine if the SCSI ID for the Printer has 
changed: 

Windows NT users: use the Virtual Console software or the SCSI Control 
Panel.

Macintosh users: use the SCSI probe feature.

b. To use the Printer to determine if its SCSI ID has changed:

On the main menu of the OCP, check the ID number in the upper right 
corner.

4. Select the desired printer and resolution.

5. Click OK to accept the information (or Cancel if you decide not to add a new 
device).
A new device icon is displayed on the Device Calibration window. 

New device 
icon
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Updating a Device

To update the name or SCSI ID for a device:

1. On the Device Calibration window, select the icon for the device to update.

2. Click the Edit icon or select File -> Edit. 
The display shows the Update a Device dialog box.

3. Edit the name, SCSI Host Adapter, or SCSI ID. 

4. Click OK to save the changes (or click Cancel to ignore the changes). 
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Deleting a Device

To delete a device and all files associated with the device:

1. Select the device by clicking once on the appropriate device icon.

2. Click the Cut icon or select Edit->Cut. 
The display shows:

3. Click Yes to delete the device and associated files (or click No to stop the 
deletion process).



Using Additional Calibration Features

2-14

Applying a Master Balance (NT Systems Only)
Master Balance is a method that allows a customer to temporarily modify printer 
neutral calibration. This may be desired for customizing a particular job or 
correcting for a short-term processing shift. It does not replace calibrating the 
printer.

1. From the Device Calibration window, double-click the device for which you 
want to perform a master balance. 

The display shows the CRT Printer Family Calibration Application window.

2. Click the Master Balance icon or select Operations->Master Balance. 
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The display shows the Master Balance dialog box.

3. Click and drag the sliders as needed for Density, Red, Green, or Blue 
balance.
For Density, Red, Green, and Blue, 1 unit of change is equal to 0.01 log 
exposure or 1 color correction (cc) units. For unit changes of less than one, 
you can type the number directly into the edit box.

4. Click OK to accept the changes (or click Cancel to cancel the master 
balance). 
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The display shows the Choose Master Balance LUT dialog box.

IMPORTANT: In the next step, do not select the default LUT.

5. Select one of the LUTs from the dialog box and click Load Selected LUT or 
click Load Custom LUT and follow the prompts to load a custom LUT.

A new LUT is calculated based on the selected LUT and the input DRGB 
values. The LUT is downloaded to the printer, overwriting the current LUT. 
This LUT will be the current printer LUT until a new LUT is sent.
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Editing the Device Configuration File
The Edit Configuration feature allows you to change the calibration configuration 
for a device if needed. Kodak recommends that you use the default settings; 
in most cases, there is no need to edit this file.

Each device has one set of configuration attributes. The Edit Configuration 
window consists of a set of six tabs—each with related configuration attributes for 
the selected device. If you click OK to save changes (includes changes made on 
other tabbed screens), you will overwrite the previous attributes used for the 
automated calibration. 

1. From the Device Calibration window, double-click the icon of the device for 
which you want to change the calibration configuration.

The display shows the CRT Printer Family Calibration Application window.

2. Click the Edit icon or select File->Edit.
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The display shows the Edit Configuration window with the Procedure tab.

3. To edit configuration information, click the appropriate tab and follow the 
instructions.

IMPORTANT: Whenever you click OK, the software assumes ALL changes to 
the Edit Configuration are complete and the Edit Configuration 
window closes. 

You can click Cancel at any time while the Edit Configuration 
window is open; any changes you made to any of the tabbed 
information are canceled and the Edit Configuration window 
closes.

Note that for Macintosh users only, you can click Default at any 
time to reset the attributes to their factory defaults and then click 
OK to save the defaults. 
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Editing Information on the Procedure Tab
The Procedure tab contains general configuration attributes as described below. 
The values in the example are the default settings. 

Procedure Tab for Windows NT Systems

Procedure Tab for Macintosh Systems
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To edit the configuration information on the Procedure tab:

1. Use the drop-down lists to change the Procedure information as needed.

2. If you have completed all editing (including information on the other tabs), 
click OK to save the changes and close the Edit Configuration window. (Or, 
click Cancel to cancel all changes.)

3. To continue making changes to the Configuration, click another tab and make 
changes as needed.

Procedure Attribute Description

Graphing Instructs the application when to display the graphs of the data

Tolerance Level Indicates whether the level of tolerance is Normal, Loose, Strict, or 
ColorMetallic Normal

Out of Tolerance Provides the flexibility to interact at each step or to use a fully automated 
calibration

Maximum Cycles Indicates the maximum number of iterations the calibration procedure will 
perform if “Out of Tolerance” is set to “Automatically iterate up to maximum 
cycles”

Processor In Control Indicates whether the Processor In Control dialog box is to be displayed at the 
beginning of the calibration process
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Editing Information on the Density Source Tab

The Density Source tab specifies how the calibration application is to receive 
density data. The values displayed in the examples are the default settings.

Procedure Attribute Description

Density Source Indicates the source (local densitometer, file or, for PC applications only, 
Centralized Densitometer Application) of the density data.

Density Source Port Indicates the name of the RS-232 port that the densitometer is connected to. 
This port is the source of the density data. The name of the port is specific to 
the computer system platform.
NOTE: This is only used if the Density Source is DTP36.

Density Source File Indicates the filename for the source of density data. This is only used if the 
Density Source is a file.

Density Source Tab for Macintosh Systems

Density Source Tab for Windows NT Systems



Using Additional Calibration Features

2-22

To edit the configuration information on the Density Source tab:

1. Use the drop-down lists to change the Density Source information as needed.

2. If you have completed all editing (including information on the other tabs), 
click OK to save the changes and close the Edit Configuration window. (Or, 
click Cancel to cancel all changes.)

3. To continue making changes to the Configuration, click another tab and make 
changes as needed.
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Editing Information on the Aim Tab
The Aim tab specifies:

• whether aims used for calibration are to be Density Aims or Lightness Aims

• whether to apply the Channel-Independent Matrix

NOTE: Copyright Detection is not available for CRT Printers.

The values displayed in the example are the default settings.
Aim Tab for Macintosh Systems

Aim Tab for Windows NT Systems
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To edit the configuration information on the Aim tab:

1. Change the Aim information as needed.

2. If you have completed all editing (including information on the other tabs), 
click OK to save the changes and close the Edit Configuration window. (Or, 
click Cancel to cancel all changes.)

3. To continue making changes to the Configuration, click another tab and make 
changes as needed.

Attribute Description

Desired Aim Indicates whether to use Density Aims or Lightness Aims for 
calibration. Using Lightness Aims will improve both the highlights 
and shadows of your prints.

Apply Channel Independent 
Matrix?

Indicates whether or not to apply the Channel-Independent Matrix 
to the aim values. If the matrix is applied, the number of cycles 
required to successfully calibrate the printer should be reduced.

Copyright Detection Table This feature is not available for the CRT Printer Family.
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Editing Information on the History Tab

The History tab specifies information about maintaining calibration history data. 
The values displayed in the example are the default settings.

History Tab for Macintosh Systems

History Tab for Windows NT Systems
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To edit the configuration information on the History tab:

1. Change the History information as needed.

2. If you have completed all editing (including information on the other tabs), 
click OK to save the changes and close the Edit Configuration window. (Or, 
click Cancel to cancel all changes.)

3. To continue making changes to the Configuration, click another tab and make 
changes as needed.

Attribute Description

Keep History For (days) Indicates the number of days that the calibration LUT, density data and 
LUT history information (trend data) is to be kept. Information older than 
the specified number of days will be deleted. 

Log Type Indicates the type of log file available during calibration. All recordable 
events or just the recordable errors can be logged to a selected filename. 

Keep log for (days) Indicates the number of days that the error and events information is to 
be kept. Information older than the specified number of days will be 
deleted.

Log File Name The name of the file that contains the logged information. 
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Editing Information on the Paper Tab

The Paper tab allows you to specify the paper being calibrated. The value 
displayed in the example is the default setting.

To edit the configuration information on the Paper tab:

1. Change the Paper Type if needed.

2. If you have completed all editing (including information on the other tabs), 
click OK to save the changes and close the Edit Configuration window. (Or, 
click Cancel to cancel all changes.)

3. To continue making changes to the Configuration, click another tab and make 
changes as needed.

NOTE: If you select Color Metallic paper, you need to change the tolerance 
level (on the Procedure tab) to ColorMetallicNormal.

Attribute Description

Paper Type Select from the list of supported paper types.

Paper Tab for Windows NT Systems

Paper Tab for Macintosh Systems
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Editing Information on the DP2 Tab (NT Systems Only)

The DP2 tab specifies whether to activate DP2 functionality, and if so, names the 
directory and filename designated for the DP2 information.

When you click the DP2 tab of the Edit Configuration window, the information 
below is displayed.

1. If DP2 is not already activated, click the Activate DP2 checkbox (click again 
to deactivate) so that the dialog box looks like the example above.

2. To change the DP2 Location, type a new directory name or click Browse and 
select another directory.

3. If needed, change the DP2 Filename.

4. If you have completed all editing (including information on the other tabs), 
click OK to save the changes and close the Edit Configuration window. (Or, 
click Cancel to cancel all changes.)

5. To make other changes to the Configuration, click another tab and make 
changes as needed.

Attribute Description

Activate DP2 Indicates if the calibration procedure should copy the generated LUT file to the DP2 
location and filename specified. When you select Operations->Send LUT or 
Operations->Master Balance, the LUT is also sent to the DP2 location to be used with 
the DP2 system.

DP2 Location Directory to contain generated LUT file for use with DP2 

DP2 Filename Name of the file containing the LUT; you are asked to confirm the file copy, if the file 
already exists.
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Editing KPIS Information (Macintosh Systems Only)

If you are using the calibration output files with the KPIS system, it is necessary to 
activate KPIS and assign a filename and location to the output file.

When you click the KPIS tab, the information below is displayed. The values in the 
example are the default settings.

1. Click the Activate KPIS checkbox (click again to deactivate).

Attribute Description

Activate KPIS Indicates if the calibration procedure should generate a LUT file for use with the KPIS 
system

KPIS Location Directory to contain generated LUT files for use with KPIS 

KPIS Filename Name of the file containing the KPIS LUT files



Using Additional Calibration Features

2-30

The display shows the Edit Configuration window with the default settings for 
KPIS Location and KPIS Filename.

2. To change the directory for the KPIS file, click KPIS Location. 
The display shows the Select KPIS Folder dialog box.

a. If needed, browse to find the folder you want.

b. Click Select “directoryname” (the example above shows Select 
“KPDM”).

c. If you use more than one device, edit the KPIS Filename to include the 
format. 



Using Additional Calibration Features

2-31

The display shows that the file name for the current device will be 
KPDMCalibration10R and will be in the directory 
CalDisk:CompositeMachine:Tables:KPDM.

The display shows the updated Edit Configuration window with updated File 
Location of CalDisk:CompositeMachine:Tables:KPDM. 

Completing the Edit Configuration
When finished, click OK to save the attributes. (Click Cancel to exit the dialog box 
without saving your changes. Click Default at any time to reset the attributes to 
their factory defaults and then OK to save the defaults.) 
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Determining Frame Counts for a Device
IMPORTANT: Determining frame counts must be done before any prints can be 

made. For each device, it is a one-time procedure.

About Frame Counts
A frame is a minimum unit of exposure time used in a CRT Printer. Frame counts 
are represented by integers. An increase in frame counts increases the exposure 
time and decreases productivity.

You need to determine frame counts as the first step to calibrating the Printer for 
each paper type and scale. 

The purpose of determining starting frame counts is to determine the combination 
of red, green, and blue frame counts that will produce optimum contrast for a 
paper type. This is usually a DMax (patch 20 or black) value within a range of 2.1 
to 2.3 density units.

The calibration software contains default frame counts for Digital III Paper on the 
selected printer. However, optimum frame count values vary among printers and 
among paper types. Because contrast is an important factor in producing quality 
prints, you will want to fine-tune the frame counts.

It is important to note that the red and green values and the green and blue values 
interact. This means changing the red value will not only change the red density, 
but will also change the green density. Changing the green density changes the 
blue density.
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Using the Software to Calculate Frame Counts
1. From the desktop of the host computer, open the KODAK PROFESSIONAL 

Device Calibration application.
The display shows the Device Calibration window. If there is no device icon 
for the device you need to calibrate, see “Adding a Device” on page 2-10.

2. Select the device to calibrate.

3. Click the Calibrate icon or select Operations->Calibrate. 
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The display shows the Calibration window.

IMPORTANT: Macintosh users: in the step below, click only one time. If you 
double-click the icon, the Calculate Frame Counts procedure will 
start again after it ends. 

4. Click the Calc. Frame Counts icon or select Operations->Calc. Frame 
Counts. 
If “Ask if processor is in control?” in the configuration file is On, the display 
shows the Process In Control dialog box below.

IMPORTANT: The processor is a critical component of printer calibration; 
monitor it on a regular basis. The calculation of frame counts can 
not be accurate if the processor is not in control.
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5. From the Process in Control dialog box, click Yes (or No to exit the 
procedure).
The status bar shows messages and the display shows the Input Frame 
Count Parameters dialog box.

NOTE: For NT systems, the display shows recommended minimum and 
maximum frame counts and maximum density for each resolution of 
the Printer.

6. Refer to the tables on the next pages for recommended minimum and 
maximum frame counts and maximum densities for each color. 

NOTE: The maximum densities are separations that when combined produce 
the “Aim” DMax density.

7. Enter or confirm the values for each color.
On the dialog box above, for a 10R test print, for example, you would enter:

Red Green Blue

Minimum Frame Count 6 1 1

Maximum Frame Count 10 4 5

Maximum Density 215 170 195
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Tables of Frame Counts and Densities

The tables below include starting minimum and maximum frame counts and 
maximum densities for Kodak Professional Digital III Paper for the Digital 
Multiprinter, Digital Multiprinter II, and the Large Format CRT Printer. These are 
default values for NT systems.

For KPDM with Digital III Paper 

Magnification
Minimum and Maximum 

Frame Counts and 
Maximum Densities

Red Green Blue

4R Frame 
Counts

 

Minimum 1 1 1

Maximum 4 3 3

Maximum Density 215 170 195

5R
Frame 
Counts

Minimum 1 1 1

Maximum 4 3 3

Maximum Density 215 170 195

6R
Frame 
Counts

Minimum 3 1 1

Maximum 5 3 3

Maximum Density 215 170 195

8R/A4
Frame 
Counts

Minimum 4 1 1

Maximum 8 3 5

Maximum Density 215 170 195

10R
Frame 
Counts

Minimum 6 1 1

Maximum 10 4 5

Maximum Density 215 170 195

11R
Frame 
Counts

Minimum 8 1 3

Maximum 12 4 6

Maximum Density 215 170 195

12R
Frame 
Counts

Minimum 10 1 3

Maximum 14 5 7

Maximum Density 215 170 195
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For KPDM II Printers with Digital III Paper 

Magnification
Minimum and Maximum 

Frame Counts and 
Maximum Densities

Red Green Blue

5R
Frame 
Counts

Minimum 1 1 1

Maximum 6 3 3

Maximum Density 215 170 195

6R
Frame 
Counts

Minimum 1 1 1

Maximum 6 3 5

Maximum Density 215 170 195

7R
Frame 
Counts

Minimum 1 1 1

Maximum 6 3 5

Maximum Density 215 170 195

8R/A4
Frame 
Counts

Minimum 1 1 1

Maximum 7 3 5

Maximum Density 215 170 195

9R
Frame 
Counts

Minimum 1 1 1

Maximum 8 3 6

Maximum Density 215 170 195

10R
Frame 
Counts

Minimum 1 1 1

Maximum 8 3 6

Maximum Density 215 170 195

11R
Frame 
Counts

Minimum 1 1 1

Maximum 9 3 7

Maximum Density 215 170 195

12R
Frame 
Counts

Minimum 1 1 1

Maximum 10 4 7

Maximum Density 215 170 195
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For KPDM Printers with Color Metallic Paper 

Magnification
Minimum and Maximum 

Frame Counts and 
Maximum Densities

Red Green Blue

5R
Frame 
Counts

Minimum 2 1 1

Maximum 8 6 6

Maximum Density 215 170 195

6R
Frame 
Counts

Minimum 2 1 1

Maximum 8 6 6

Maximum Density 215 170 195

7R
Frame 
Counts

Minimum 4 1 1

Maximum 10 6 6

Maximum Density 215 170 195

8R/A4
Frame 
Counts

Minimum 6 2 2

Maximum 12 6 6

Maximum Density 215 170 195

10R
Frame 
Counts

Minimum 9 2 1

Maximum 16 7 6

Maximum Density 215 170 195

11R
Frame 
Counts

Minimum 11 3 2

Maximum 18 10 7

Maximum Density 215 170 195

12R
Frame 
Counts

Minimum 12 3 3

Maximum 19 10 8

Maximum Density 215 170 195
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For LFCRT Printers with Digital III Paper 

8. From the Input Frame Count Parameters dialog box, click Make Test Print (or 
Cancel to exit the procedure).

Magnification
Minimum and Maximum 

Frame Counts and 
Maximum Densities

Red Green Blue

5R
Frame 
Counts

Minimum 2 1 1

Maximum 8 4 5

Maximum Density 215 170 195

6R
Frame 
Counts

Minimum 5 1 2

Maximum 9 4 6

Maximum Density 215 170 195

8R
Frame 
Counts

Minimum 10 2 4

Maximum 14 6 8

Maximum Density 215 170 195

10R
Frame 
Counts

Minimum 15 2 4

Maximum 19 6 8

Maximum Density 215 170 195

11R
Frame 
Counts

Minimum 20 3 9

Maximum 24 7 13

Maximum Density 215 170 195



Using Additional Calibration Features

2-40

NOTE: Any of the messages below may be displayed if the values do not fall 
within valid ranges:

9. If you receive one of the messages above, make the correction and click OK.
Messages display on the status bar as the test target is printed and the 
densitometer initializes.

10. When 
“Waiting for 6 strips of density data. See the Densitometer for instructions...” 
or “Waiting for density data file from Centralized Densitometer Application” 
displays, 

a. Perform a Batch Cut at the OCP.

b. Wait for latent image keeping (LIK) to stabilize before processing. The 
minimum suggested time is fifteen minutes.

c. Send the test target prints to be processed. 

Continue with “Reading the Densities.”

Message Explanation/Remedy

Some minimum frame count values are 
greater than their corresponding maximum 
frame count values.

The maximum frame count value for a color must be 
greater than its corresponding minimum value. 

Enter the suggested values from the table.

The difference between minimum and 
maximum frame count values must be equal 
to or greater than 1 and less
than 10.

The minimum and maximum frame count values can 
not be the same; for example, a minimum value of 3 
and a maximum value of 3 is invalid. The maximum 
value cannot be more than 9 greater than the minimum 
value; for example, a minimum value of 3 and a 
maximum value of 13 is invalid.

Enter the suggested values from the table.

Some frame count values are out of range. 
Valid frame count values range from 1 to 198.

Enter the suggested values from the table.

Some density values are out of range. Valid 
density values range from 10 to 255.
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Reading the Densities

1. Trim the processed test target print on the dashed line and along the top so 
the print passes through the densitometer at the correct locations.

2. Align the pass 1 arrowhead on the print (shown below) with the vertical 
groove on the front of the densitometer. 

3. Put the print firmly in the densitometer. Keep a slight pressure on the print as 
it moves through the densitometer until you feel a resistance and the display 
shows “Reading.”

4. A short beep from the densitometer, followed by “Pass 1 of 6 OK” and “Read 
CRT-AFC PA2,” indicates a successful read. 
A long beep with a message to re-read the pass indicates an unsuccessful 
read. If the read continues to be unsuccessful, cancel, then restart the 
calibration.
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5. When the read is successful, repeat steps 2, 3, and 4 until all six passes are 
complete. Align the arrowhead at passes 2, 3, 4, 5, and 6, respectively. 

NOTE: For instructions on using the densitometer, see the densitometer 
manual.

If the Density Readings are Unsuccessful
If a dialog box displays stating that an error occurred while communicating with 
the densitometer or that the density data is not in the correct format, click Retry 
after making sure that the densitometer is on, the connection is secure, and the 
densitometer is calibrated.

Saving the Calculated Frame Counts

After a successful density read, the frame counts are calculated and the display 
shows the Choose a PaperPak for New Frame Counts dialog box.
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Saving the Frame Counts in the Selected PaperPak File

1. With the PaperPak file highlighted (in the example, defaultPaperPak.pap), 
click Selected PAP.
The display shows the Confirm Target PaperPak dialog box.

2. Click Replace to replace the frame counts (or Cancel if you do not wish to 
replace the frame counts). 
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Saving the Frame Counts in a Custom PaperPak

1. From the Choose a PaperPak for New Frame Counts dialog box, click 
Custom PAP. 
The display shows the standard Open dialog box. Make sure the CalLUTS 
folder is displayed.

2. Highlight a custom file with a file extension of “.pap” and click Open.
The software checks that the file contains valid data; if not, a message is 
displayed. If the file is valid, the display shows the Confirm Target PaperPak 
dialog box.

3. Click Replace to replace the existing frame counts as indicated (or Cancel if 
you do not wish to replace the frame counts).
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Saving the Frame Counts in a New File 

1. From the Save Frame Counts dialog box, select New PAP. The display shows 
the Enter New PaperPak filename dialog box. Make sure the CalLUTS folder 
is displayed.

2. Type a file name, making sure it ends with the file extension “.pap” and click 
Save.

The display shows the Confirm Save Frame Counts dialog box.

3. Click Replace to save the frame counts for the indicated scale (or Cancel if 
you do not wish to replace the frame counts). 

new.pap
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Sending PaperPaks, LUTs, or Test Targets for Devices
Only do these procedures when determining frame counts or when you are sure 
of what the outcome will be. Kodak can not be responsible for invalid results.

Sending PaperPaks

The Send PaperPak feature enables you to overwrite the current printer 
PaperPak. This option sends the selected PaperPak to the Printer, overwriting 
any existing PaperPak.

1. On the Calibration window, click the Send PaperPak icon or select 
Operations->Send PaperPak. 

The display shows: 
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2. Either:
• with the selected PaperPak highlighted, click Load Selected PAP, or
• click Load Custom PAP; then browse the standard file dialog that allows 

PaperPaks to be imported from other areas on the hard disk or from a 
removable disk; select the PaperPak file you need.
The default location for PaperPaks is the CalLUTS folder. 

(Click Cancel to go back to the Calibration window.)

The system downloads the highlighted PaperPak. 

The display shows the Confirm/Edit Frame Counts dialog box.

NOTE: The circled values may be different from what you see.

3. Click OK, or if needed, make changes to the frame counts and then click OK.
The status bar shows “The PaperPak was sent successfully.”

(Click Cancel to go to the Calibration window.)
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Sending LUTs

The Send LUT feature enables you to overwrite the current printer LUT. This 
option sends the selected LUT to the Printer, overwriting any existing LUT. 

1. On the Calibration window, click the Send LUT icon or select 
Operations->Send LUT. 

The display shows the Send LUT to Printer dialog box.

CAUTION: Macintosh users: If you are selecting a LUT in step 2 as part 
of the process for determining frame counts, you must select 
“Pick Custom LUT” and select a calibration LUT from the 
CalLUTS folder.

2. Either:
• select one of the LUTs from the dialog box, then click Load Selected LUT, 

or
• click Pick Custom LUT; then browse the standard file dialog that allows 

LUTs to be imported from other areas on the hard disk or from a 
removable disk; select the LUT file you need.
The default location for calibration LUTs is the CalLUTS folder.
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Sending Test Targets

The Send Target to Printer feature enables you to send any properly formatted 
test target file to the Printer without going through the calibration process. The test 
target file must contain image data in the correct format (raw RGB planer) for the 
Printer.

On the Calibration window, click the Send Target icon or select 
Operations->Send Target. 

For Macintosh Systems
The display shows the Open dialog box. You may need to change the directory on 
this dialog box to get to the Targets folder.

1. Scroll to the test target you need and click Open. 
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The display shows the Send Target to Printer dialog box.

2. If needed, edit the values.

3. Click OK to save the values (click Cancel to exit). 
The test target is sent to the Printer.

For Windows NT Users
The display shows the Send Target to Printer dialog box.

1. Either:
• Edit the values, if needed, or 
• Click Browse; then follow the prompts to load a custom test target and edit 

those values, if needed.

2. Click OK to save the values (click Cancel to exit). 

The test target is sent to the Printer.
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Viewing Graphs
The View Graphs feature provides access to graphs generated by the last 
calibration process for a device.

1. Click the Graphs icon or select View->Graphs. The display shows the most 
recent graph, based on the last calibration data. 

To view a different graph (change the graph settings) from the same 
calibration data:

1. Select the desired Graph Type.

2. Select the desired Display Data.

3. Select the desired Display Planes.

4. Click OK.
The displays that follow are examples of the Values, Tolerance, and Spread 
graphs. 
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Value Graph

The Value Graph shows actual data in relation to aim data. Ideally, all three colors 
would fall on the aims line.
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Difference Graph

The Difference Graph shows if the actual values are within tolerance. You can see 
from the graph below that the result of the calibration is an out-of-tolerance 
situation.
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History Graph

The History Graph shows the values for each calibration cycle.
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Creating a Density File for Use with Calibration
During calibration, you have the option of obtaining density data from a file or by 
scanning a processed test target through an X-RITE DTP 36 densitometer. The 
option is determined by the entry in the calibration configuration file. If the 
configuration file is set up to receive density data from a file and you are creating 
the file:

1. Scan the print into your densitometer.

2. Save the data to file using the density data file format specification (see “File 
Formats” below). The Kodak Professional Device Calibration software does 
not perform this function.

3. Move the density data file that you just saved to the “Dens” folder within the 
device folder for your specific device. The filename should match the Density 
Source File selected on the Density Source tab of the Edit Configuration 
window (see “Editing Information on the Density Source Tab” on page 2-21).

File Formats 
NOTE: If a file contains data in a tabular format, each entry may be separated by 

multiple spaces and tabs; however, when the file is saved by the application, 
each group of multiple spaces and tabs is automatically converted to a 
single tab.

DensityDataRaw (TECHNET Format)
Example:

R2340 G1000 B2010
R2350 G1010 B2020
R2360 G1020 B2030
R2370 G1030 B2040
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Connecting the X-Rite DTP36 Densitometer to the Host 
Computer

1. Plug the flat 8-pin telephone-type connector into the port on the densitometer.

2. For Macintosh systems, plug the other end of the cable into the printer port of 
the computer.

3. For Windows NT systems, plug the other end of the cable into the appropriate 
serial port.

NOTE: It is not necessary to connect the extra pieces of the cable.

IMPORTANT: Densitometers require calibration at regular intervals. Refer to your 
densitometer manual or instructions on how to calibrate your 
densitometer and perform a calibration.
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3   Installing and Using the Centralized
Densitometer Application

IMPORTANT: This chapter applies only to users of WINDOWS NT Systems.

The Centralized Densitometer Application topics covered in this section include: 

• Installing the application on a WINDOWS NT System

• Modifying printer and port information 

• Viewing graphs

Installing the Centralized Densitometer Application
If you have a network of printers and will be using the Centralized Densitometer 
application, install it on the host computer that will be connected to the central 
densitometer.

NOTE: The Kodak Professional Device Calibration application must be installed 
on each host PC connected to a printer. The Centralized Densitometer 
application must be installed on the computer connected to the 
densitometer.

System Requirements
• WINDOWS NT 4.0 with service pack 3 or higher

• 170 KB available disk space 

• At least 2 MB main system memory

• CD ROM Drive
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Installation Procedure
1. If you are installing the software from the supplied CD-ROM: 

a. place the CD in your CD-ROM drive. 

b. When the Browser appears, select the type of CRT Printer you are using.

2. If you are downloading the installation files from the Kodak web site, go to 
http://www.kodak.com/global/en/service/software/kproHost/kpdm.shtml. 

3. Under the heading Product Support, select Drivers, Software and Firmware.

4. Select Calibration Utilities.

5. Under the heading Download File, select KODAK PROFESSIONAL Device 
Calibration.
The Save As dialog box appears. 

6. Either accept the default path and file name or select another path and file 
name and save the file. 

7. Open the installation file (KODAK PROFESSIONAL Device Calibration.exe).
The display shows a splash screen for KODAK PROFESSIONAL Device 
Calibration and a Setup message.

8. After the Welcome dialog box is displayed, click Next.

http://www.kodak.com/global/en/service/software/kproHost/kpdm.shtml
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9. Read the license agreement.
• To accept the terms and continue the installation, click Yes. 
• Or, to cancel the installation, click No.

10. Read the readme information, then click Next.

The display shows a dialog box for choosing the destination location.

11. Either accept the default path and folder or click Browse to select another 
path and folder.

The Setup Type dialog box appears.

12. Select Custom and click Next.

The Select Components dialog box appears.
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13. Click to check the box next to Kodak Professional Device Calibration – 
Centralized Densitometer and click Next.

14. Click Next to install the software on your system.

The Setup Status dialog box appears. You do not need to do anything unless 
you want to cancel the setup.

15. When the setup is complete, click Finish to restart the host computer.

16. If you used a CD to install the software, remove the CD-ROM and store it in a 
safe place.
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Using the Centralized Densitometer Application
1. Click the Windows Start button and select Programs -> Eastman Kodak -> 

KProApplications -> KODAK PROFESSIONAL Device Calibration -> KODAK 
PROFESSIONAL Centralized Densitometer to open the Centralized 
Densitometer application. 

The display shows the Centralized Densitometer Application window.

With the Kodak Professional Device Calibration - Centralized Densitometer 
Application, you can:

• add or delete a printer

• change the densitometer port

• for a selected printer
– change the printer information
– measure the density during a calibration cycle
– view calibration graphs 

Adding a Printer 

1. Click the Add Printer icon or select File->New on the Centralized 
Densitometer Application window. 
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The Add New Printer dialog box appears.

2. Either type a path or click Browse and select a path. Click OK.

The display shows the Centralized Densitometer Application window with the 
new printer added. 
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Deleting a Printer 

1. Highlight the printer you want to delete.

2. Click the Delete icon or select Edit->Delete Printer on the Centralized 
Densitometer Application window. 

The display shows the following dialog box.

3. Click Yes to delete the printer.
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The selected printer is no longer visible in the Centralized Densitometer 
Application window.
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Changing Printer Information

1. Highlight the printer for which you want to change the information (location).

2. Click the Printer Info icon or select Edit->Printer Info on the Centralized 
Densitometer Application window. 

The Update Printer Information dialog box appears.

3. Change the location for the printer as needed and click OK.
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Changing the Densitometer Port

You can change the designation of the port on your host computer to which the 
densitometer is attached.

1. Select Edit->Edit COM Port on the Centralized Densitometer Application 
window. 

The Change Densitometer Port dialog box appears.

2. Click in the circle next to either COM1 or COM2 and click OK. 
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If you change the port, a message is displayed on the status bar of the 
Centralized Densitometer Application window.
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Measuring Densities During a Calibration Cycle
IMPORTANT: To use the centralized densitometer application for measuring 

densities for a calibration cycle, the density source of “centralized 
densitometer” must have been selected in the edit configuration 
dialog for the device being calibrated; see “Editing Information on 
the Density Source Tab” on page 2-21.

1. Open the Centralized Densitometer Application. The display shows the 
Centralized Densitometer Application window.

2. Highlight the printer.

3. Click Measure or select Operations->Measure to measure the target images.

4. At the densitometer, measure the densities (see “Using the Densitometer to 
Read Densities” on page 1-9).

When the densities are measured, the status bar on the Centralized 
Densitometer Application window displays “Ready.”

The measured densities are automatically sent to the CRT printer’s host 
computer.



Installing and Using the Centralized Densitometer Application

March 2001 3-13

Viewing Calibration Graphs

The View Graphs feature provides access to the available graphs from the most 
recently completed calibration of the selected device.

For examples of the graphs, see “Viewing Graphs” beginning on page 2-51. The 
Value and Difference Graphs reflect the densitometer values that were last read. 
The History Graph displays the data from completed calibrations.

To view calibration graphs from the Centralized Densitometer application:

1. Highlight the printer you want to view graphs and click Graphs or select 
View->Graphs.

One of the graphs appears; typically it is the Value graph.

2. Select the Graph Type that you want to view. When the graph is displayed, 
select the type of data and planes that you want to see displayed. 

NOTE: You will get a message if there is no calibration data for the selected 
device.
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Appendix A: Troubleshooting

This section lists errors you may occasionally have while using:

• the KODAK Device Calibration Software and the CRT Printer Family 
Calibration Software

• the X-RITE DTP36 Densitometer

Calibration Graph
The graph below is an indication that the calibration performed was out of 
tolerance.

This may result from invalid densitometer readings. If you see a graph that looks 
similar to the one above, perform another calibration cycle.
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Calibration Errors

Numeric Calibration Error Codes

 Code Status Message Possible Cause/Subsystem Possible Solution

1 The following file is 
locked:_filename_.

The system is trying to access a 
file that is currently in use.

Close any other applications that 
may be accessing the file.

2 The following file is 
protected:_filename_.

The system is trying to access a 
protected file.

Change the protections on the file 
to grant access to the user.

3 The following file was not 
found:_filename_.

The system was trying to access 
a file that it could not find.

Verify that the filename on one of 
the configuration dialog windows is 
correct.

4 Error:_oserror_occurred 
during operation:_operation_ 
on file:_filename_.

An operating system error 
occurred.

• Rerun the application.
• Reboot the operating system

5 The following file is in an 
incorrect format:_filename_.

The file does not conform to the 
application specification.

Verify the file format. 

6 The following file already 
exists:_filename_.

The system is trying to save to a 
file that already exists.

• Delete the existing file.
• Change the filename.

7 There is not enough space to 
create:_filename_.

The system is trying to save a file 
but there is not enough disk 
space.

Remove any unnecessary files to 
increase free disk space.

8 There are too many files to 
open _filename_.

Too many files are open. Close some files and or 
applications.

9 You do not have permission 
to open file _filename_.

The file permission is invalid. Rerun the application.

10 Error copying print LUT to 
DP2 folder (can’t open 
_filename_.

The folder doesn’t exist or is read-
only.

Modify the protection on the folder.



Troubleshooting

March 2001 A-3

11 Error creating DP2 LUT 
folder

A folder of the same name may 
exist.

Change the selected folder name.

101 No response from 
device:_devicename_.

The device is not responding to 
the system.

Verify that the device is connected 
and on-line.

102 Device not 
found:_devicename_.

The system was trying to access 
a device that it could not find.

Verify that the device name on one 
of the configuration dialog 
windows is correct.

103 The following device is 
indicating it is not 
ready:_devicename_.

The device is not ready. Wait several minutes and try the 
activity again.

104 The following device is 
busy:_devicename_.

The device is busy. Wait several minutes and try the 
activity again.

105 The following device is not a 
TTY port:_devicename_.

The port name in the 
configuration file does not refer to 
a valid serial port.

Change the port name in the 
configuration file to a valid serial 
port.

106 The following device is 
closed:_devicename_.

The serial port closed during 
system reading.

• Verify that no other application 
is accessing the port.

• Restart the application.

107 No data on 
device:_devicename_.

No data is available for the 
system to read on the serial port.

• Verify that the densitometer is 
connected correctly.

• Restart the application.

108 Error:_oserror_occurred 
during operation:
_operation_ on device:
_devicename_.

An operating system error 
occurred.

• Rerun the application.
• Reboot the operating system
• If problem continues, call for 

service.

109 Invalid Device ID:
_devicename_.

A new device was created with an 
incorrect device ID.

Edit the device ID to reflect the 
correct device ID.

110 Unable to perform operation:
_operation_ 
Status Message:_statmsg_ 
Error Message:_errmsg_.

An unknown device error 
occurred.

Use the information in the status 
message and error message to 
resolve the device error.

 Code Status Message Possible Cause/Subsystem Possible Solution
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111 There is insufficient memory 
for the requested operation 
on device:_devicename_.

The application does not have 
enough memory to complete the 
operation.

Close the other applications and 
unnecessary windows.

112 A communications time-out 
occurred during operation on 
device:_devicename_.

The connection between the 
printer and host computer was 
lost.

Check that all cables are properly 
connected.

113 A device driver for the 
following device could not be 
found:_devicename_.

The application could not find the 
necessary device software to 
communicate with the printer.

Make sure that the Calibration 
Application and ASPI SCSI device 
driver are installed correctly.

114 An error occurred during 
communications to the 
following device:
_devicename_.

• The cable between the printer 
and the host computer is worn.

• One or more of the 
connections between the 
printer and the host computer 
has malfunctioned.

• Check that all cables are 
properly connected.

• Check the cables and 
connections between the printer 
and the host computer for wear 
and if necessary, replace them.

115 An operation error occurred 
during communications to 
the following device:_
devicename_.

• The cable between the printer 
and the host computer is worn.

• One or more of the 
connections between the 
printer and the host computer 
has malfunctioned.

• Check that all cables are 
properly connected.

• Check the cables and 
connections between the printer 
and the host computer for wear 
and if necessary, replace them.

116 A software warning has been 
issued by the following 
device: _devicename_ Error 
Message: _errmsg_

A software error has occurred on 
the printer.

Resolve printer error condition.

117 A software error has been 
detected by the following 
device: _devicename_ Error 
Message: _errmsg_

An error has occurred on the 
printer.

Resolve printer error condition.

118 A SCSI ID for the following 
device was not found: 
_devicename_.

SCSI driver not found. Reinstall the SCSI driver on host 
computer.

 Code Status Message Possible Cause/Subsystem Possible Solution
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119 The wrong SCSI ID was 
specified for the following 
device: _devicename_.

SCSI ID is incorrect. Set the Target SCSI ID to the 
printer SCSI ID.

120 This device has been setup 
for the wrong model of 
printer: _devicename_.

The chosen device has not been 
found.

Verify chosen device matches the 
printer model.

121 Unable to read STATUS from 
device: _devicename_.

Unable to see the printer. Check SCSI cable connections.

122 The selected LUT contains 
data that exceeds the limits 
of this printer.

Trying to send a 12-bit LUT to a 
10-bit printer.

Select a 10-bit LUT file.

201 An error occurred while 
trying to allocate memory.

The system is trying to allocate 
memory; however, no memory is 
available.

Close any unnecessary 
applications.

202 The following parameter is 
invalid:_parametername:
_parametervalue_.

An internal error occurred with the 
software.

• Restart the application.
• If problem continues, call for 

service.

203 The function is not supported 
by the class.

An internal error occurred with the 
software.

• Restart the application.
• If problem continues, call for 

service.

204 This function has not been 
implemented.

An internal error occurred with the 
software.

• Restart the application.
• If problem continues, call for 

service.

205 Must enter the following 
field:_field_.

The operator left a configuration 
field blank.

Enter information in the blank 
configuration field.

301 The following key was not 
found: _key_.

• An internal error occurred with 
the software. 

• One of the files was edited 
manually and a key was 
changed.

• Restart the application.
• Restore the key to its previous 

value.
• If problem continues, call for 

service.

 Code Status Message Possible Cause/Subsystem Possible Solution
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302 The following grouper was 
not found:_grouper_.

• An internal error occurred with 
the software. 

• One of the files was edited 
manually and a grouper was 
changed.

• Restart the application.
• Restore the grouper to its 

previous value.
• If problem continues, call for 

service.

303 The call depends on a 
current grouper, but the 
current grouper has not been 
set.

An internal error occurred with the 
software.

• Restart the application.
• If problem continues, call for 

service.

501 An error occurred while 
applying the data.

601 A bad count was entered. 
The expected count 
was:_count_.

• A file was edited manually and 
an incorrect number of rows 
was entered.

• An internal software error 
occurred.

• Manually enter the correct 
number of rows in the file.

• If problem continues, call for 
service.

602 An error occurred during the 
calculation process.

An internal error occurred with the 
software.

• Restart the application.
• If problem continues, call for 

service.

701 Patch _patch_, column 
_column_, value _value_ is 
beyond tolerance 
_tolerance_ for aim _aim_.

A density patch was out of 
tolerance.

Perform another calibration cycle.

702 Patch _patch_ has a spread 
of _spread_ which is out of 
range _range_.

The spread between colors for a 
given density patch is out of 
tolerance.

Perform another calibration cycle.

703 CalToleranceFile can only be 
initialized once.

An internal error occurred with the 
software.

• Restart the application.
• If problem continues, call for 

service.

704 CalToleranceFile:: 
initialize must be called first.

An internal error occurred with the 
software.

• Restart the application.
• If problem continues, call for 

service.

 Code Status Message Possible Cause/Subsystem Possible Solution
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801 Could not find row:_row_. An internal error occurred with the 
software.

• Restart the application.
• If problem continues, call for 

service.

802 Could not find 
column:_column_.

An internal error occurred with the 
software.

• Restart the application.
• If problem continues, call for 

service.

803 Could not find element - 
column:_column_.
row:_row_.

An internal error occurred with the 
software.

• Restart the application.
• If problem continues, call for 

service.

804 Row value was not set 
before using.

An internal error occurred with the 
software.

• Restart the application.
• If problem continues, call for 

service.

805 Column value was not set 
before using.

An internal error occurred with the 
software.

• Restart the application.
• If problem continues, call for 

service.

806 Error deleting row:_row_. An internal error occurred with the 
software.

• Restart the application.
• If problem continues, call for 

service.

807 Element at row:_row_; 
column:_col_
value:_val_ failed audit.

An input file had incorrectly 
formatted data in it at the location 
indicated.

• Verify that you are using the 
correct file.

• Edit the file and correct the 
format.

910 Configuration file 
field:_filename_is invalid. 
Calibration will be cancelled.

The user entered an incorrect 
value in a configuration file.

• Enter the correct value.
• Reinstall the application.
• If problem continues, call for 

service.

911 Error_errcode_occurred. 
Processing stopped.

An internal error occurred with the 
software.

Restart the application.

919 Error occurred preparing to 
handle exit from Kodak 
Device Calibration. Will not 
perform cleanup at exit.

An internal error occurred with the 
software.

Restart the application.

 Code Status Message Possible Cause/Subsystem Possible Solution
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921 Unable to return the printer 
to its original state. Fix 
printer problem and re-
calibrate.

The application was trying to 
cancel but received an error when 
sending the original LUT back to 
the printer.

Printer is in an unknown state. 
Correct any printer problems and 
restart the application.

922 There is already a printer 
open. Please close the open 
printer first.

User tried to open a printer when 
the printer was already open.

Close the open printer.

923 An error occurred during the 
loading of a printer. Please 
check to make sure the file 
chosen was of the correct 
type and/or format.

An error occurred during the 
loading of a printer.

Check that the file chosen was the 
correct format or type.

924 No printer loaded. The operator has not yet opened 
a printer.

Open a printer.

941 The height and width values 
do not agree with the size of 
the target file. 

The specified size does not match 
the file size.

Enter the correct file size.

942 Unable to configure 
densitometer. Densitometer 
configuration file may be 
corrupt or lost.

The file CalDevDensGen2.cfg is 
corrupt or lost.

Restart the application. If problem 
continues, call for service.

1003 Unable to load default 
configuration file:_filename_.

The default configuration file was 
deleted or renamed or moved.

Restore the file manually or 
reinstall the software.

1004 Unable to set values
 in new configuration file.

An internal error occurred with the 
software.

Restart the application.

1005 Unable to save configuration 
file:_filename_.

The system is trying to save a file 
but there is not enough disk 
space.

Remove any unnecessary files to 
increase free disk space.

1006 Configuration file field:_field_ 
is invalid.

The user entered an incorrect 
value in a configuration file.

• Enter the correct value.
• Reinstall the application.

 Code Status Message Possible Cause/Subsystem Possible Solution
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1007 Unable to remove 
directory:_directory_.

The user does not have the 
authority to update the directory.

Verify that the user has update 
authority on the directory.

1101 Density DMIN/DMAX points 
are invalid.

Density points are invalid. Reread density values on 
densitometer or make a new 
calibration print.

1102 Density data is not 
monotonic increasing.

Density data is invalid. Reread density values on 
densitometer or make a new 
calibration print.

1103 Exceeded maximum number 
of allowable data errors.

Density data is invalid. Reread density values on 
densitometer or make a new 
calibration print.

1104 Asymmetric Density 
Groupings are invalid.

Density data is invalid. Reread density values on 
densitometer or make a new 
calibration print.

1201 Unknown response from 
densitometer.

During initialization, the 
application received an unknown 
response from the densitometer.

Verify that the baud rate of the 
densitometer matches that of the 
applications configuration.

1202 Error:_error_from 
densitometer.

An unexpected error was returned 
from the densitometer.

Calibrate the densitometer. If the 
problem continues, check the 
manual for the densitometer.

1203 Error: Number of patches 
seen by densitometer is 
incorrect. 

Unable densities on densitometer. Try adjusting frame counts or 
reread the density patches on the 
densitometer.

1300 Values have not been loaded The matrix file is missing. Create a new device.

1301 Data or Matrix files have not 
yet been loaded

The matrix file is missing. Create a new device.

1302 Data cannot be saved, must 
first apply the matrix

The matrix file is missing. Create a new device.

 Code Status Message Possible Cause/Subsystem Possible Solution
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Non-Numeric Calibration Error Messages

Error Message Possible Cause/Subsystem Possible Solution

An underrun error occurred during 
communications to the following 
device.

• The cable between the printer 
and the host computer is worn.

• One or more of the connections 
between the printer and the host 
computer has malfunctioned.

• Check that all cables are properly 
connected.

• Check the cables and 
connections between the printer 
and the host computer for wear 
and, if necessary, replace them.

An UNKNOWN error occurred 
during communications to the 
following device.

An unknown error occurred in the 
application.

• Restart the calibration application.
• If the problem continues, make 

sure that the Calibration 
Application and ASPI SCSI 
device driver are installed 
correctly.

Device not found. The host computer attempted to 
contact the printer at the specified 
SCSI ID but did not get a response.

• Make sure that the printer is 
turned on and is on-line.

• Make sure that the Calibration 
Application and ASPI SCSI 
device driver are installed 
correctly.

Invalid Device ID. The host computer attempted to 
contact the printer at the specified 
SCSI ID but did not get a response.

Make sure that the printer is turned 
on and is on-line.

The following device is busy. The printer at the specified SCSI ID 
is busy. 

Check that all cables are properly 
connected.

The following device is closed. The connection between the printer 
and host computer was lost.

Check that all cables are properly 
connected.
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Densitometer Errors

Code Message Explanation

<01> BAD_COMMAND The densitometer does not recognize a command.

<02> PRM_RANGE_ERROR One or more data or address parameters is out of range. See 
the command guide for parameter limits.

<03> DISPLAY_OVERFLOW_ERROR An attempt was made to read or write beyond the end of the 
display. Valid addresses for the display range from 0x00 to 
0x20 (0 to 31 decimal).

<04> MEMORY_OVERFLOW_ERROR An attempt was made to read or write beyond the end of the 
external RAM within the densitometer. Valid addresses for the 
external RAM range from 0x0000 to 0x7fff (0 to 32767 
decimal).

<05> INVALID_BAUD_RATE The parameter included with the BR command was invalid. 
Valid parameters are 06 (1200), 0C (2400), 18 (4800), 30 
(9600), and 60 (19200).

<06> INVALID_PHOTO_STRIP The specified photographic control strip does not exist.

<07> TIMEOUT The time interval between characters has exceeded 5 
seconds.

<08> PRM_SYNTAX_ERROR. An invalid character was found in the command string.

<09> INVALID_PASS The requested pass does not exist for the currently stored 
strip (e.g., specifying pass 5 for a 4-pass strip).

<0a> INVALID_STEP The requested step does not exist for a given pass in the 
currently stored strip (e.g., specifying step 25 or step 0 on a 
21-step pass).

<0b> NO_DATA_AVAILABLE Data was requested but no data is stored in memory.

<0c> MISSING_PARAMETER One or more required parameters was omitted.
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<10> LAMP_MARGINAL The lamp output is at approximately 50% of its original 
brightness. Strip readings can still take place, but to maintain 
proper accuracy and repeatability, replace the lamp as soon 
as possible.

<11> LAMP_FAILURE The lamp is either burned out or its output is at a level too low 
for acceptable readings. The densitometer will not read strips 
until the lamp is replaced and the densitometer is re-
calibrated.

<12> STRIP_RESTRAINED During calibration, the calibration strip was held or restrained 
as it passed through the unit. Do not hold the strip as it is 
reading and make sure the read path is clear of any foreign 
matter.

<13> BAD_CAL_STRIP During calibration, the calibration strip was unrecognizable. 
The strip may have been inserted backwards, upside down, or 
held so that it slipped on the internal rollers. This also may be 
an indication that the strip needs to be replaced.

<14> MOTOR_ERROR During calibration, a problem was detected with the drive 
motor. This can occur if the strip is held back while reading.

<20> INVALID_READING The strip just read was not recognized by the densitometer.

<21> WRONG_COLOR After a strip reading, the step wedge just read was not the 
color specified for that pass or strip as defined in the 
densitometer editor menu.

<23> NEEDS_CALIBRATION The calibration check that was done immediately after reading 
a strip indicated that the unit needs calibration. This occurs 
when the reading taken from the opal glass after the strip exits 
the unit differs from the reading taken during calibration by 
more than the internal tolerance (default is 0.1 X, Y, or Z). The 
tolerance can also be changed by the RCI command CC 
(Check Cal tolerance).

Code Message Explanation
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<26> NO_VALID_DATA The measure type is set to CONT and the strip that was read 
contained nothing but base material. Base material is defined 
as measuring less than 0.5D in the visual channel. For 
negative (black) based materials, base material is defined as 
measuring less than twice the reflectance of a measurement 
taken near the trailing edge of the strip. the densitometer uses 
a measurement taken at about 0.25 inches from the trailing 
edge of the strip to determine if it is positive or negative 
based. Any measurement greater than 10% reflectance is 
considered positive based; anything else is considered 
negative based.

<27> BAD_PATCH If the Pattern Recognition comparison window is set to 0 or 1, 
this error may result when a single patch on the strip is bad 
due to dirt, smears, creases, etc. (See explanation of CW 
command for more information.)

<30> BAD_STRING_LENGTH A strip definition string received as part of the DS (Define 
Strip) RCI command did not contain the correct number of 
characters.

<31> BAD_CHARACTER A non-printable character was received in one of the name 
fields (strip name or pass name). Printable characters are in 
the range 0x20 to 0x7E, inclusive.

<32> BAD_MEAS_TYPE The value for the measure type field was greater than 3. Valid 
values are 0 through 3.

<33> BAD_COLOR The value for the color field was greater than 9.

<34> BAD_STEPS The value for the number of steps was greater than 72.

<35> BAD_STOP_LOCATION The value for the guide setting was less than 4 or greater than 
30.

<36> BAD_OUTPUT_TYPE The value for the output type was greater than 5.

<37> MEMORY_ERROR The definition could not be stored.

Code Message Explanation
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<38> BAD_N_FACTOR The n-factor (used in Dot calculations) is either less than 0500 
(0.500) or greater than 4500 (4.500).

<39> STRIP_DOESNT_EXIST The SD command was issued and the requested strip does 
not exist.

<3A> BAD_MIN_MAX_VALUE The value for the min/max field was greater than 4.

<40> BAD_SERIAL_NUMBER An attempt was made to redefine one of the stored serial 
numbers with a number containing one or more invalid digits.

Code Message Explanation
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Appendix B: Manually Determining
Frame Counts

When choosing frame counts to reach a target DMax, choose the red, green, and 
blue values that are close to, or slightly higher than, the optimum DMax range (for 
Digital III paper, red – 2.25, green – 2.20 and blue – 2.15 are optimum).

NOTES: Not all photographic papers support a DMax of above 2.1 in all three 
colors.

The combined characteristics of the cathode ray tube (CRT) and Digital 
Photographic paper results in a very low number of frame counts 
needed for the green exposure. This produces a coarse adjustment of 
the green Dmax. When determining the green frame counts, select the 
first value that produces a density higher than the Dmax aim, even 
though the difference is significant. The calibration software has 
sufficient range to accommodate the higher Dmax.

When you enter frame counts in this procedure for a Digital Multiprinter with 
Digital III paper, use the initial values for the most frequently used scales 
(magnifications) that are suggested below:

The recommended procedure for determining the best frame counts is to create 
three test targets, each one using:

• the recommended values from the chart above

• the recommended values minus one

• the recommended values plus one

Scale 
(magnification)

Red Green Blue

12R 11 3 5

11R 10 2 5

10R 8 2 3

8R 6 2 2

6R 5 1 2

5R 4 1 2

4R 3 1 2
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For example for 8R, you would send test targets with these sets of frame counts:
R G B
6 2 2
5 1 1
7 3 3

Next, you would process the test prints, then measure and record DMax for each 
test target. The test target that produces the best DMax values (for Digital III 
paper: red – 2.25, green – 2.20, blue – 2.15) determines the starting frame counts.

Procedure to Determine the Frame Counts for a Scale

Use this procedure with Macintosh and Windows NT systems.

1. Press Jog&Start at the operator control panel (OCP) to put the Printer in 
“Ready” mode. 

2. On the Device Calibration window, select the icon of the device for which you 
are determining frame counts. (If the device is not on the Device Calibration 
window, add it; see “Adding a Device” on page 2-10)

3. Click Calibrate. 
The display shows the Calibration window.

4. From the Calibration window, in sequence:

a. Click Send PaperPak to send the PaperPak (see “Sending PaperPaks” on 
page 2-46) with the recommended frame counts.

For example, if you are determining frame counts for an 8R device, edit 
the frame counts to be 6, 2, and 2.
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IMPORTANT: When sending the LUT file, make sure you select “Send 
Custom” then navigate to the CalLUTS folder and choose the 
default12.cal file.

b. Click Send LUT to send the LUT file (see “Sending LUTs” on page 2-48).

c. Click Send Target to send the Test Target (see “Sending Test Targets” on 
page 2-49).

5. Repeat step 4 (a, b, and c) twice for the second and third set of frame counts 
(in the example, the values would be 5, 1, 1 and 7, 3, 3).

6. Process the test targets.

7. Set up the densitometer to read the test target:

a. To go to the main menu of the densitometer, simultaneously press the two 
right-most buttons.

b. Select PAP from the main menu on the densitometer.

8. Send one pass of the first processed test target through the densitometer and 
record the Dmax for each color:

a. To go to the main menu of the densitometer, press the two right-most 
buttons simultaneously.

b. From the main menu of the X-Rite DTP36 densitometer, press [P1].

c. Press [Data].

d. Read the DMax patch (Pass 1). 

e. Record the values directly on the test target.

9. Repeat step 8 for the second and third test targets.

10. Determine which set of frame counts gave the best DMax reading:
• Using the 8R values as an example, the recorded DMax values are:

R G B R G B

6 2 2 2.20 2.46 2.26

5 1 1 1.80 1.55 1.92

7 3 3 2.44 2.68 2.35

In this example, the red and blue values are within the preferred 2.2 to 2.3 
range. 

Although the green value of 2.46 is slightly higher than the preferred 
maximum of 2.3, a frame count of 1 gives a DMax of only 1.55 and a frame 
count of 3 gives a DMax of 2.68, which is even higher than 2.46.

Therefore, in this example the starting frame counts for 8R are 6, 2, 2.
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• Using 10R values as an example, the three test targets are sent with the 
frame counts below and produce the DMax values shown:

R G B R G B
8 2 3 1.85 2.09 2.24
7 1 2 1.50 1.16 1.96
9 3 4 2.12 2.51 2.35

In this example, the blue value of the second print is within the 2.2 to 2.3 
range. 

The green value of 2.51 from the third print is as close as possible to the 
preferred values (frame counts must be integers; a frame count of 4 would 
produce an even higher DMax). 

Therefore, the starting 10R frame counts for green and blue are 3 and 3, 
with red not yet determined (none of the frame counts produced a DMax of 
2.25). 

In this example it is necessary to send two more test targets.

R G B R G B
10 3 3 2.26 2.52 2.25
11 3 3 2.38 2.53 2.22

So, for 10R the starting frame counts are 10, 3, 3.

You have determined the best frame counts for this scale. Use these frame counts 
for calibrating the Printer for this device.
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